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Introduction

Stereology is a set of techniques for extracting 3D information from 2D images.
Traditional stereological methods are referred to as model-based because they make the
assumption that targets are spheres or ellipsoids. Because the mathematics behind model-
based methods is complex, it is tempting to disregard these implicit assumptions and
simply accept the methods as useful tools. Recently, however, a new set of stereological
procedures has been developed. This “new stereology” differs from the traditional forms
because it makes no assumptions regarding the shape of the objects to be measured. It is
called unbiased stereology.

The optional Stereology module for MCID Analysis uses the new, unbiased stereology.
This document describes our stereological procedures for counting, sizing, and three
dimensional (3D) surface measurements.

The Stereology module has a dedicated user interface and set of tools that run within the
MCID Analysis environment. The user interface provides convenient selection of the
factors that configure your system for stereology. To enable the Stereology module,
select Settings > Study > Stereology or click the Stereology icon in the study type
Shortcut Bar:

v

Stereology

Available Measures

Most stereological measurements are ratios or densities. For example, we measure
numerical density (Na, number of targets per unit area; Nv, number of targets per unit
volume) or surface density (Sv, surface area of targets per unit volume). You can also use
these core measurements to calculate other parameters. For example, you can derive the
total number of targets, or the total surface area, or the average surface area per target.

If stereological measures are to be reported in relevant spatial units (e.g., mm’, pm?), the
images must contain the appropriate spatial calibrations (e.g., Distance, Area, Section
interval). See the online MCID Analysis Reference Manual, Chapter 6: Calibrating
Images for calibration instructions.

To select the kinds of measurements you wish to make, open the Sample menu and select
the Measures selection option (Figure 1).

MCID Analysis stereological measures are grouped into three categories: 2D Frames,
3D Probes, and 3D Disectors. These measurements can be selected singly or in
combination, allowing multiple stereological measurements to be carried out
simultaneously. 3D Disectors measures, however, cannot be combined with any other
measures.

03-MW-0080 Imaging Research Inc.
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Figure 1: The Measures Selection dialog box is used to select the kinds of stereological
measures you wish to make.
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2D Frames Measures

2D Frames measures are calculated from the 2D dimensions of a “sampling frame” and
the target profiles contained within it. A sampling frame (Gunderson, 1977) is a
rectangular tool, with two inclusive and two exclusive boundaries. A target is accepted
only when it is completely inside the frame, or is touched by the inclusive boundary but
not the exclusive boundary. In theory, the sampling frame gives any target an equal
chance of being sampled, regardless of its 2D shape or size.

Ns: Number of 2D Targets
Number of target profiles contained within the sampling frame.

As: Area Sampled

Sampled area (area of the sampling frame). If a Distance or Area calibration is not in
effect, As is the number of pixels contained in the counting frame.

Na: 2D Numerical Density

Number of target profiles per unit area. Na is calculated from the area of the sampling
frame and the number of targets sampled in the frame. If a Distance or Area calibration is
not in effect, Na is expressed as the number of target profiles per pixel” (abbreviated in the
data table as “pixel ™).

Vv: Volume Ratio

Volume ratio (Equation 1) is also often called volume fraction. It is the ratio of target
profile volume to sample volume.

Equation 1 Vv =est [a/As]

Vv volume ratio

03-MW-0080 Imaging Research Inc.
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a sum of the area of all the target profiles in the sample

As area of the sampling frame

3D Probes Measures

3D Probes measures are calculated from a set of linear test probes oriented around points
in a sampling grid. If data are to be expressed in spatial units, images must be calibrated
to a reference scale.

Aa: Area Ratio

This is a simplified volume ratio measure, which divides the number of grid points
overlaying a target by the total number of grid points measured.

Sv: Mean Surface Density

Surface area per unit volume (Equation 2). If a Distance calibration is not in effect, Sv is
expressed as the number of targets per pixel (abbreviated in the data table as “pixel”).

Equation 2 Sv=est. [2(P/L)]

Sv surface area per unit volume of the reference space

est.  is estimated by

P total number of intersections between probes and profile boundaries
L total length of probes within the reference space

“Reference space” here is the total containing space. P can be automatically computed
from the test probes.

Vm: Mean Volume

Mean volume of sampled target profiles (Equation 3). If a Distance calibration is not in
effect, Vm is expressed in “voxels”.

Equation 3 Vim = mean [(pi/3) x (P)]

Vm  mean volume

1 intercept length - an intercept in a random direction in 3D through a random
test point hitting a cell

3D Disectors

The “disector” was proposed as a direct estimator of the number of 3D objects, unbiased
by their shape and size. It consists of two parallel sections, the reference section and the
lookup section, separated by a known distance. On the reference section, target profiles
are detected within a sampling frame (as described in 2D Frames Measures, above). To be
accepted, targets must be absent from the lookup (i.e., previous) section. This condition
results in the counting of cell tops. Use of the lookup section is critical, because the cells
seen in the sampling frame are a biased sample in the height dimension. Bias results
because the section hits cells with a non-uniform probability proportional to their height.

03-MW-0080 Imaging Research Inc.
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Higher cells are more likely to be sampled than thinner ones. However, the subset of cells
not hit by the look-up section is an unbiased, uniform sample (Sterio, 1984).

We use the term unbiased to mean that the probability of having a cell included in the
subset is independent of the cell’s shape or size. We use the term uniform to mean that
the lack of bias is present in all three spatial dimensions.

3D Disectors measures are derived from aligned serial sections separated by a known
distance. When the disector is applied to each section, it identifies new “target tops” seen
within the sampling frame and computes both the number of 3D targets and the volume.

Note: Since the first section in the series has no “lookup” section, no data is reported
for the first image.

If data are to be expressed in spatial units, images must be calibrated to a Distance
reference scale. A Section interval must also be specified in the Distance calibration.

N: Number of 3D Targets

Number of 3D targets contained in the sample, which are not present in the preceding
(i.e., lookup) section.

Nv: Numerical Density of 3D Targets

Number of targets per unit volume (Equation 4). If a Distance calibration is not in effect,
and if a Section interval is not specified, Nv is expressed as the number of targets per
pixel® (abbreviated as “pixel ™).

Equation 4 Nv=N/Vs

Nv numerical density of 3D targets
N number of 3D targets counted
Vs volume sampled (see Equation 5)

Vs: Volume Sampled
Volume sampled (Equation 5). If a Distance calibration is not in effect, and if a Section
interval is not specified, Vs is expressed in “voxels”.

Equation 5 Vs=Asx h

Vs volume sampled
As area of sampling frame
h section interval (distance between images)

You may be wondering about the difference between the volume sampled (Vs) and the
volume of the reference space V(ref). Conceptually, these terms are different, though we
simplified our discussion by equating the reference space and the space actually sampled
by the disector(s). In this case, V(ref) is numerically equal to Vs, and N is equal to the
sum of the “target tops” counted. However, we can set a general rule that we should use
Equation 5 when we deal with small, clearly demarcated volumes, that are well sampled
by our disectors. This gives us the density of targets in our sampled volume. If our
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interest is to estimate the total number of targets in a much larger V(ref) than we can
sample, Equation 6 should be used. This gives us an extrapolated target number.

The estimate of the total number of 3D targets may be simplified as the following:

Equation 6 N = est. [Nv x V(ref)]

N

est.
Nv
V(ref)

total number of 3D targets

is estimated by

numerical density of 3D targets

volume of the reference space

The volume of the reference space V(ref) generally means a region of interest, such as the
cerebral cortex.

Summary

Stereological measures are summarized in Table I, below. The table also indicates how
each measure is estimated, how the specimen must be sectioned (see below), and which
spatial calibration is necessary to express the data in appropriate units.

Table I: Stereological measurements supported in MCID Analysis.

Measure Definition Method Name Section Type Calibration
Ns Number of 2D targets Unbiased sampling and Vertical or [UR Not
sampled counting frame required
Na Numerical density (2D) Unbiased sampling and Vertical or [UR | Distance or
counting frame Area
As Sampled 2D area Unbiased sampling and Vertical or IUR | Distance or
counting frame Area
Vv Volume Ratio Cavalieri’s principle Vertical or IUR Not
required
Aa Area Ratio Point-sampled-intercept | Vertical or [IUR Not
required
Sv 3D surface density Test probes Vertical or [UR Distance
Vm Mean target volume Point-sampled-intercept | Vertical or [IUR Distance
N Number of 3D targets Disector Serial Not
required
Nv Numerical density (3D) Disector Serial Distance,
Section
interval
Vs Volume sampled Disector Serial Distance,
Section
interval
03-MW-0080 Imaging Research Inc.
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Section Types

To ensure that stereological estimates are unbiased, tissue sections must be obtained in an
appropriate fashion. This ensures that every part of the specimen has the same chance of
being included in the sample, and that the sample is representative of the entire specimen.

Estimates based on disectors (e.g., 3D target count, 3D target density) require Serial
sections. All other estimates require Vertical or Isotropic Uniform Random (IUR)
sections. Each of these section types has its own set of algorithms for generating test
probes, ensuring that the probes are isotropic in 3D space.

Serial Sections

Stereological estimates that are calculated from disectors require serially adjacent
sections, separated by a known distance and perfectly registered (aligned) with each other.
The sections may be physical (i.e., physically cut) or optical (i.e., different focal planes
through a thick specimen). The interval between the sections must be small enough so
that no object of interest will escape detection between sections. The most effective
interval between sections is about 30% of the smallest feature of interest.

Vertical Sections

A vertical section is a plane perpendicular to a given “horizontal” plane. No special
meaning is attached to the “horizontal”, other than as a reference plane which defines the

orientation of the sections. There are three ways to define the vertical direction (Baddeley
et al. 1986):

1. Find a naturally defined, intrinsic vertical direction in the specimen. In muscle
tissue, for example, cylindrical fibers run roughly parallel to the macroscopic
longitudinal orientation of the tissue. We could take vertical sections with
reference to the fiber orientation, in either the longitudinal or the coronal planes.

2. A uniquely identifiable base plane is set as a horizontal reference plane, and the
vertical direction would be defined to be normal to the horizontal. Many
synthetic structures in material science and metallurgy, and flat tissues such as
skin can be measured using this strategy.

3. Define the vertical direction artificially.
Generate vertical sections using the following rules:
1. All vertical sections must be normal to the pre-defined horizontal plane;

2. Vertical sections must have random positions, and random direction, which is
normal to the horizontal plane.

Isotropic Uniform Random (IUR) Sections

IUR sections are not used as frequently as vertical sections, because they are difficult to
generate and must satisfy the following conditions:

1. There is no preference in selecting any particular orientation within the region of
interest (isotropic selection). That is, the sectioning plane is randomly selected.

03-MW-0080 Imaging Research Inc.
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2. The location of the section is randomly selected from within the sample (uniform
selection). There is no preference in selecting a section from any particular
position.

In practice, IU sections are usually generated according to a procedure called orientator.
See Mattfeldt et al. (1985) for details.

The Stereology Module

The Stereology module works in conjunction with the MCID Analysis automatic target
detection and measurement feature (Scan Area). You first define a set of target criteria
that distinguish features of interest (i.e., potential target profiles) from other image
features, based on any combination of density, size, or shape. Once you have established
an appropriate set of criteria, you use one of the Stereo Sample Tools (i.e., a 2D sampling
frame) to define a region of interest. MCID Analysis then searches the region for
features that satisfy all of the detection criteria, generates the appropriate test probes, and
reports the stereological data in the data table.

The basic procedure is as follows:
1. Load the images.
2. Make all necessary calibrations (e.g., Distance)
3. Select the measures you wish to make.
4. Establish detection criteria for target profiles.
5

Where required, adjust the sampling grid and specify the way in which the
specimen was sectioned (e.g., Vertical or [UR)

6. Sample the images.
7. Edit the sampled images as required.
8. Compile the results in the Stereology table.

This section describes the features and functions of the Stereology study type. At the end
of this document is a Stereology Tutorial, which provides an explicit step-by-step guide
through the sampling process.

The Stereo Sampling Grid

To calculate 3D Probes measures (Sv, mean surface volume; Vv, mean volume; Aa, area
ratio), linear probes are oriented around regularly spaced points in a “sampling grid.”
Before the specimen is sampled, the sampling grid should be adjusted so that no feature of
interest contains more than a single grid point. The section type must also be specified, to
ensure that the appropriate algorithms and test probes are used. For access to these
settings, click on the Stereo Grid icon loc in the Application toolbar:

LR

SN—r”
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A sampling grid appears over the image in the current channel. The Sampling Design
dialog box also appears (Figure 2), as well as a set of Stereo Grid tools. The Sampling
Design dialog box is used to specify a section type and sampling grid size. The Stereo
Grid tools allow you to adjust the grid with the mouse.

Figure 2: The Sampling Design dialog box is used to specify a section type and sampling
grid size.

Sampling Design e 5[

—Section Type

 Yertical ¢ lsotopic Uniform Bandom

—Sampling Grid
Mumber Interyals
Fows: IE; I?g pixel
Colurmnsz: |?‘ |?‘8 pirel
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Poszition: = Fixed " Systematic shift

0k, I Cancel Save $tate| Help I

Section Type

Specify whether sections are Vertical or IUR. Each of these section types has its own set
of algorithms for generating test probes, ensuring that the probes are isotropic in 3D
space.

Sampling Grid Options

The sampling grid should be adjusted so that no feature of interest contains more than one
grid point. The size of the sampling grid is defined by the number of Rows and Columns
and the Intervals between them. Values may be changed by typing new values into the
appropriate entry fields. Click on the [Refresh] button to update the grid after entering
new values.

In theory, the position of the sampling grid should be systematically shifted by half of the
grid point interval for every image in the stack to achieve better measurement precision.
In practice, a fixed grid position will serve just as well. Either a Fixed grid position, or an
(automated) Systematic shift of grid position may be selected.

Stereo Grid Tools

The size and position of the sampling grid may also be adjusted with Stereo Grid Tools
(Figure 3). Values in the Rows, Columns and Interval fields are automatically updated
as the grid is adjusted.

Figure 3: Stereo Grid Tools are used to adjust the size and/or position of the sampling
grid.

” Steren@rid Tools - [+ 35 @ 2 - |
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Shift

The Shift tool is used to select a new location for the sampling grid. Move the cross-hair
cursor over any grid point. When the cross-hair turns into a pointing finger, drag the grid
point to a new XY coordinate and release the mouse button. The entire grid is redrawn
using these coordinates as a reference.

++ | Size

The Size tool is used to set a new grid point interval for the sampling grid. Move the
cross-hair cursor over any grid point and it becomes a pointing finger. Press the left
mouse button and the grid point becomes one corner of a variable dimension box, defined
by its three neighboring points. Drag the grid point to a new location and release the
mouse button. The grid is redrawn using these coordinates as a reference.

. Autoscan B

The Autoscan B tool automatically establishes an optimal grid point interval based on the
size of the largest feature of interest. To use this tool, the target must be clearly distinct
from the regions around it. Place the hollow arrow cursor on a background next to a
target and click the left mouse button. When the cursor becomes a solid arrow, place it
over the largest feature of interest and click again. The target outline is shown in red and
its dimensions set the optimum grid size for this sample.

Outline

The Outline tool establishes an optimal grid point interval based on the dimensions of a
hand-drawn target. Hold down the left mouse button and trace around the border of the
largest potential target. Release the mouse button and MCID Analysis uses the feature’s
dimensions to set the optimum grid size for this sample.

Pixel Info

The Pixel Info tool cursor is a cross hair with a single pixel in the middle. Position the
cross hair anywhere on the image and click the left mouse button. The X Y coordinates
and the density value for the pixel under the cross hair is displayed at the top left of the
Image View. Use it to have a quick look at pixel density values.

Establishing Target Detection Criteria

The Stereology module works in conjunction with the MCID Analysis automatic target
detection and measurement feature, called “Scan Area” (see MCID Analysis Reference
Manual, Chapter 7: Automated Target Detection for complete details). You first define a
set of target criteria that distinguish features of interest from other image features, based
on any combination of density, size, or shape. Once you have established an appropriate
set of criteria, you use one of the Stereo Sample Tools (see below) to define a region of
interest. MCID Analysis then searches the region for features that satisfy all of the target
criteria, generates the appropriate test probes, and reports the stereological data in the data
table.

03-MW-0080 Imaging Research Inc.
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Click on the Scan Area icon (located in the Application toolbar) to turn on the automatic
target detection feature:

Selecting the Scan Area icon turns the automatic target detection feature on and off.
Selecting the icon while pressing the <Ctrl> key calls up the Scan Area dialog box
(Figure 4).

Figure 4: The Scan Area dialog box defines the segmentation range and has a variety of
target detection options.

x

— Option Surmnary

Targets defined in: Current channel Target size: 0ff
Target zcan mode: Marmal Filled: 0ff
teazures: Group Single pizel: Count
K.eep only last zcan shapes Criteria: Off

— Segmentation Fange

Denzity: ROD Highlighting
wiidth; 103 levels 3 Red -
Center: 04783 i~ Mane

—llj pr— ' Target
- " Background

[ Keep highlight

3 0.9031 [T dutomatic

Undo I Clear |

Optionz. . I Ok I Cancel | Save state | Help I

The Scan Area dialog box is used to define target detection criteria. In the middle of the
dialog box there is a set of slider controls for setting the upper and lower target density
limits. Together, these limits are called a “Segmentation Range”. The Highlighting
box is simply a visual aid to help establish the Segmentation Range. The Option
Summary section displays the current status of optional features that can be modified by
clicking on the [Options...] button.

Setting a Segmentation Range

Density thresholds (light vs. dark) are the simplest criteria for target detection. You
define a segmentation range using the upper and lower thresholds. Pixels having densities
that fall within the segmentation range are regarded as valid targets. Pixels that are lighter
or darker than the threshold values are ignored. In Figure 4, pixels lying between 0.2684
and 0.9031 ROD are valid targets.

When adjusting the segmentation range, the goal is to set thresholds that distinguish
targets from background. A very narrow segmentation range may yield pure targets, but
genuine targets go undetected. By contrast, a wide segmentation range may include some
background features as targets, or leave halos of background around each genuine target.

03-MW-0080 Imaging Research Inc.
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It is much easier to set the correct threshold range if you have the Highlighting drop
down list set to Targets (see below).

The segmentation range can detect either dark or light targets. MCID Analysis is equally
capable of detecting dark targets against a light background or light targets against a dark
background.

Highlighting

It is much easier to discriminate targets from background if they are shown in some easily
perceived color. Select a target color from the Highlighting drop down list, then click on
the [Target] radio button. Alternatively, you can color the background instead of the
targets. To do this, select a color from the Highlighting list then click on the
Background radio button. If you select None, neither target nor background are
highlighted (this is the default condition).

While you are setting the segmentation range, you usually want to see targets filled with
color. The color fill is removed when you work with the images. Color fill only re-
appears when the automated scan detects targets. If you prefer to see target pixels colored
at all times, click on the Keep highlight checkbox.

Processing the Image

Before establishing a density segmentation range, you may wish to perform a few image
processing operations to make genuine targets stand out more clearly from background or
modify the target structure. Image processing operations and filters are available through
the Transform operation window (see MCID Analysis Reference Manual, Chapter 12:
Processing Images). Because image processing operations change image data you should
limit pre-processing only to the extent needed for setting an adequate segmentation range.

Various image processing features are available. In some instances, you could perform a
series of Max or Min operations to establish more distinct boundaries between closely
spaced targets and fill in holes within them. The Target Accentuate filter maximizes the
contrast between small image features and larger background regions (to apply the Target
Accentuate filter, press <F12>). This filter reduces the contrast of all image components
but more so for larger targets.

Establishing Spatial and Logical Criteria

A threshold operation rarely eliminates all the invalid targets from the scan. Usually, bits
of background or other image features have density values similar to those of valid
targets. In a scan based entirely upon density thresholds, these image characteristics may
be confused with valid targets. To avoid this problem, MCID Analysis lets you include
additional spatial and logical target acceptance criteria. These target criteria include
minimum and maximum area, minimum roundness, minimum and maximum chord, and
other parameters.

You set spatial and logical criteria by clicking on the [Options] button in the Scan Area
dialog box. This produces the Scan Area Options dialog box. Selecting Criteria on and

03-MW-0080 Imaging Research Inc.
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then clicking on [Modify Criteria] calls up the Target Acceptance Criteria dialog box
(Figure 5).

The dialog box looks and works much like a calculator. To construct logical target
criteria, use the number, symbol, and mathematical operation buttons in combination with
the list of spatial measure categories on the right.

Suppose you only wish to count image features that are between 100 and 200 um? in size.
Open the Basic Morphometry group of measures to see the [Area] measure. Use the
[Area] measure and the buttons to construct one line that says “[Area] > 100" and a
second line that says “[Area] < 200” (double-click on the [Area] measure to add it to the
statement). You can use any number of criteria. If targets are round, for example, you
could also construct another line that says “[Form Factor] > .8”. (See MCID Analysis
Reference Manual, Chapter 5: Selecting Measures for more discussion on how to use
these measures).

When you are constructing logical criteria, you should use numerical values that
correspond to your current spatial calibration units (see MCID Analysis Reference
Manual, Chapter 6. Calibrating Images). 1f your image is not calibrated, spatial unit
values are expressed in pixels.

Figure 5: The Target Acceptance Criteria dialog box is used to define spatial and logical
target criteria.
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When Target Criteria are not Adequate

If it is not possible to establish detection criteria that adequately distinguish features of
interest from background, then each feature of interest must be manually defined when
you sample the image. See “Manual Target Definition”, below.

Stereo Sample Tools

Stereo Sample Tools (Figure 6) are used in conjunction with the MCID Analysis
automatic target detection feature (Scan Area) to define regions of interest and derive
stereological measures from the objects (target profiles) found within them.
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Figure 6: The Stereo Sample Tool toolbar.
” Sterec Sample Taols = T '.I_ B |

The basic sample tool is the “sampling frame” or “counting frame” (Figure 7), a
rectangular box with broken lines for its upper and right boundaries (inclusion lines) and
solid lines for its left and lower boundaries (exclusion lines). The sampling frame counts
targets that fall completely within its boundaries plus any target, which touches the
inclusion lines. Targets that touch the exclusion lines are not counted.

Q)
&

] ‘I“
oS &

Two sampling frames are available, one that can be dragged to any size and moved about,
and one that remains in a fixed position.

Continuous Frame

The Continuous Frame can be positioned anywhere within the image. To adjust the size
of the frame, move the mouse while holding down the <Ctrl> key. Click the left button
to sample.

Channel Frame

The Channel Frame can be locked into a fixed position within a channel. To adjust the
initial size of the frame, move the mouse while holding down the <Ctrl> key. To position
the frame, move the mouse while holding down the <Shift> key.

Defining Outer Scan Areas

Recall that the sampling frame counts and samples any target that touches its inclusion
lines, even if the target extends beyond the frame. MCID Analysis must consequently
scan a region outside of the frame, adjacent to the inclusion lines. To specify the amount
of adjacent image area to scan, double-click on one of the frame tool icons. This will
display the Stereology Frame Cursor Settings dialog box (Figure 8).
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Figure 8: The Frame Cursor Settings dialog box is used to define the amount of adjacent
image area to scan, and to enable automatic sampling across an entire image set.
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If you select the Use frame with margin option, MCID Analysis scans the area within
the counting frame plus a small region adjacent to the inclusion lines. The adjacent region
extends to about one third of the length and width of the sampling frame. If you select the
Use full image option, MCID Analysis scans the entire image area adjacent to the
inclusion lines. This option may tax system memory if you are working with very large
(e.g., tiled) images.

Labeling Data
MCID Analysis tracks stereological data using the following labeling scheme:

Subject Animal/Subject used in study.

Section Tissue section obtained from subject (image filename or channel number).
Region Anatomical area.

Target Area of image sampled with a single sampling frame.

Subject, Section and Region labels are located at the top of the Sample window. Before
gathering data, click on the Subject and Region headings and enter the appropriate labels.
The default label is “?”.

MCID Analysis automatically creates Section labels as each image is sampled. If you
are working with image files, MCID Analysis will use their filenames as labels. If
images are digitized into consecutive channels, MCID Analysis will use channel numbers
for Section labels.

Collecting Data

To gather data, select one of the sampling frame tools and position it over the image. The
general rule is to size the frame to select as many target profiles as possible, while making
sure that the broken sides of the frame (inclusion lines) avoid targets that intersect the
edges of the image.
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Press the left mouse button to sample the image. MCID Analysis first scans the sampling
frame (and the region adjacent to the inclusion lines) for targets that fall within the
segmentation range. If you have established spatial criteria, MCID Analysis scans the
frame a second time and searches for targets that also fulfill these additional criteria. As
the scan proceeds, MCID Analysis displays “valid” targets (i.e., those that meet the
spatial criteria as well as the density criteria) in one overlay color and “excluded” targets
(i.e., those that meet the density criteria but not the spatial criteria) in another.
Stereological measures are derived from “valid” targets and reported in the data table.

Repeat the sampling procedure for all other images in the series, or use auto-sampling
feature (described below) to sample the entire image set in one operation. If you are
working with 3D Disectors (i.e., with aligned serial sections), be sure to sample the same
2D coordinates in each image. Use the Channel frame tool or the auto-sampling feature
to keep the same coordinates across all sections.

Automatic Sampling Across an Image Set

You can analyze your specimens one section at a time, or as a stack containing any
number of sections. Use the Image > Image set > Retrieve command to load multiple
image files into consecutive channels or into an image file storage list (see MCID Analysis
Reference Manual, Chapter 2: Loading Image Files for complete details). You can then
perform an automated analysis across the entire stack with a single operation.

To enable auto-sampling mode, double-click on whichever counting frame tool you will
use to gather data (i.e., Continuous frame or Channel frame). When the Frame Cursor
Settings dialog box appears (Figure 8), turn on the Auto sampling on sections option.

When you are ready to sample the images, click the counting frame in the first image in
the series. When the Auto Sampling On Sections dialog box appears (Figure 9), specify
the range of images to sample.

Figure 9: The Auto Sampling On Sections dialog box. If images are loaded into
consecutive channels, specify the range of channels to sample. If images files are loaded
into a storage list, the filenames of the first and last images are displayed.
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Images
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Click the [Sample] button to begin sampling the image set. MCID Analysis generates
the appropriate test probes, scans each image for targets that meet the detection criteria,
and reports the results in the data table.
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Displaying Data
Measurement results are displayed in the Sample window in both tabular and graphical
forms.

Figure 10: Tabular data display.

: [
Section Target s - count Ag-Ume2 MNa-#/ Um2 Wiy - ratio Sw-pme f pm3 W - 3
341 1 17.000 172919.000 9.8312e-005 0.066 nmez 17276.768
SWe i 17.000 172919.000 9.8312e-005 0.066 0014 16051.733
5v3 1 17.000 172919.000 9.8312e-005 0.066 0.015 23105.264
Svd 1 17.000 172919.000 9.8312e-005 0.066 0.om 21310.775
Data Tables

The Table toolbar (View > Table bar) provides two data tables for displaying
stereological data:

The default data table is the Target table (Figure 10). It displays data from individual
sampling frames for the specified Subject, Section and Region label. Use this table to
gather and edit data.

The Stereo table summarizes data gathered from all counting frames across all sections
(images). MCID Analysis computes and displays the appropriate summary value for
each measure and summarizes the appropriate stereological parameters upon which the
measure is based (e.g., # frames, # intercepts). Data may be sorted by Subject and/or
Region label.

Please note, although summary statistics (Mean, SD) are displayed at the bottom of the
Target table, these values should not be used to express final results. In order to generate
measures that are representative of the entire specimen, we must pool data obtained from
individual samples (i.e., across all sections). Always use the Stereo table for reporting
final results.

Levels of Data Display

Within each summary table, data may be sorted across or within Subject, Section and/or
Region labels. Click on the =1 button (next to the Subject heading) to select different
combinations of Subject, Section and Region display modes.

Current region  Displays data gathered under the currently selected Region label
(default Region display mode). Click on the Region heading to select
another label.
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All regions Displays data gathered under all Region labels. Data are labeled with
individual Region names.

Current section Displays data gathered under the currently selected Section label.

All sections Displays data gathered from all Section labels (default Section display
mode). In the Target table, data are labeled with individual Section
names (i.e., image filename or channel number).

Current subject Displays data gathered under the currently selected Subject label
(default Subject display mode).

All subjects Displays data from all Subject labels. Data are labeled with individual
Subject names.

Graphical Data Display

The graph area in the Sample window displays the incremental calculation of any measure
in the data table, over all sampled sections. Figure 11, for example, shows the estimation
of mean surface density (Sv) plotted against the number of test probes used.

Figure 11: Graphical display of mean surface density (Sv), plotted against the number of
probes.
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The graphical display is an effective way to monitor the reliability of particular measures
(e.g., Sv) as sampling progresses. If the estimated measure is fairly stable (as in Figure
11, above), it is an indication that enough measurements have been made to reach a
reliable result. Further measurement is probably unnecessary. In contrast, if the graph
shows variable measurements, this indicates that more data should be taken.

Select which measure to plot by clicking on its column heading in the data table. When a
different measure is selected from the data table, the graph is redrawn and the axis labels
are updated. The following shows what MCID Analysis plots for each of the measures:

Ns -- Number of 2D targets sampled, plotted against the number of counting
frames used.

As -- Area sampled, plotted against the number of counting frames used.
Na -- 2D target density, plotted against the number of counting frames used.

Aa -- Area ratio, plotted against the number of intercepts used.
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Vv -- Estimated volume ratio, plotted against the number of counting frames
used.

Sv -- Mean surface density, plotted against the number of probes used.
Vm -- Mean target volume, plotted against the number of intercepts used.
N -- 3D target count, plotted against the number of disectors used.

Vs -- Volume sampled, plotted against the number of disectors used.

Nv -- 3D number density, plotted against the number of disectors used.

Editing Data

Automated measurements depend upon an accurate discrimination between target and
background. Making this discrimination (usually on the basis of a density threshold) is
known as segmentation. Automated segmentation works very well with clearly stained or
labeled targets, but can be more difficult with many less clearly demarcated specimens.
Therefore, some post-sampling editing of data may be necessary.

There are two ways to edit stereological measures. One way is to add or delete targets in
the sampled image(s). The other way is to edit the stereological probes upon which
particular measures are based. For example, we can edit Vm by adding an intercept at any
sampling grid point, deleting any intercept, or by modifying the length of any intercept.

To add or delete targets in a sampled image, press <F8> or select the Stereo editing tools
option from the Edit menu. Select Scan windows editing as the editing mode (Figure 12).
Use any of the available Scan Editing tools to add or delete targets in the current image.
Data are updated accordingly. Click [Done] to exit data editing mode.

Figure 12: MCID Analysis provides two editing modes for stereological data. Select
“Scan windows editing” to add or delete targets in sampled images. Select “Stereology
editing” to edit the probes upon which a measure is based.

Stereology Editing Modes il

Select mode

* Scan windows editing

" Stereclogy editing [4a

|

To edit specific stereological probes, first select the measure you wish to edit by clicking
on its column heading in the data table. Press <F8> (or select the Stereo editing tools
option from the Edit menu) and select Stereology editing as the editing mode. Use the
appropriate Stereo Editing Tool to edit the probes that appear over the sampled image.
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Data is updated accordingly as each probe is edited. Press [Done] when all images have
been edited as necessary.

Scan Edit Tools

The Scan Edit toolbox/toolbar (Figure 13) contains tools for adding and deleting targets
in scanned images. They are also used to manually define target profiles when it is not
possible to use the MCID Analysis automatic target detection feature.

Figure 13: The Scan Edit toolbox.
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Deleting Targets

Select the Delete tool to delete a target profile (filled with red overlay) from the scan area.
When you click the Delete tool on any sampled target profile, the overlay color disappears
and data are updated accordingly.

Adding Targets

The remaining Scan Edit tools operate just like standard Sample tools. For example,
select the Outline tool to manually trace around the border of an undetected feature of
interest. Click inside the outline and MCID Analysis adds the feature to the sample.
Data are updated accordingly.

Note: MCID Analysis will only derive data from feature(s) of interest, which lie
completely within the boundaries of the sampling frame or touch an inclusion
line.

Stereo Editing Tools

Stereo Editing Tools (Figure 14) are used to edit the test probes used to estimate
particular stereological measures. These tools are not available until an associated
measure (Sv, Vm, N, or Nv) is selected in the data table.

Figure 14: Stereo Editing Tools.
” Stereo Editing Tools TIE I |

Surface probe

The Surface probe tool is used to edit the mean surface density measure (Sv), by adding
or deleting intersections between test probes and target profile boundaries. On the
sampled image, intersections are shown as small green circles. To delete an intersection
point, click on it with the right mouse button. Click the left mouse button to add a new
intersection point.
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@ Volume probe

The Volume probe is used to edit the mean target volume measure (Vm) measure. It is
useful if segmentation is unreliable and you need to manipulate the lengths of the
intercepts accurately. Click the cursor on any sampling grid point (displayed in green on
the sampled image) and MCID Analysis creates a linear probe oriented around the point.
To extend the probe, place the cursor on one end of the probe and drag it outward. The
probe extends to the point where you release the mouse button. To shorten the probe,
click the right mouse button on the point where you wish the probe to end. To delete a
probe, hold down the <Ctrl> key and click on the probe with the right mouse button.

Area probe

The Area probe tool is used to edit the area ratio measure (Aa), by adding or deleting
intersections between test probes and targets. On the sampled image, intersections are
shown as small yellow circles, which appear over grid crosses. To delete an intersection
point, click on it with the right mouse button. Click the left mouse button to add a new
intersection point over a grid cross.

Profile pointer

The Profile pointer is used to edit 3D target count (N) or 3D target density (Nv)
measures. On sampled images (other than the first image), 2D target profiles are
displayed in the current cursor color. Profiles that were not present in the preceding
section (i.e., the tops of new 3D targets) are outlined in another color. To unmark a 3D
target, click on it with the right mouse button. It is then treated as a 2D target profile. To
designate a 2D target profile as a 3D target, click on it with the left mouse button.

Pixel Info

The Pixel Info tool cursor is a cross hair with a single pixel in the middle. Position the
cross hair anywhere on the image and click the left mouse button. The XY location and
the density value for the pixel under the cross hair is displayed at the top left of the Image
View. Use it to have a quick look at densities without actually taking data samples.

You can set the Pixel Info tool to express pixel location and density in various units.
Click on the Pixel Info icon while pressing the <Ctrl> key to define the location and the
density units.

Manual Target Definition

If it is impossible to establish an automatic target detection criteria that adequately
discriminates between features of interest and other image features (i.e., if it is not
possible to use the MCID Analysis automated target detection feature at all), then each
feature of interest must be manually defined.

If the Scan Area feature is not turned on when you sample an image, MCID Analysis
will automatically enter the data editing mode and display the Scan Edit toolbox. Use
any of the available tools to define all target profiles that fall completely within the

03-MW-0080 Imaging Research Inc.



MCID Analysis Application Guide Stereology 21

boundaries of the counting frame, and all targets, which touch the inclusion boundaries.
Data from the sample are updated each time a target profile is defined.
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Stereology Tutorial

The following is a step-by-step guide through the Stereology study type. Before
proceeding with this tutorial, you should know how to carry out the following procedures:

e retrieve and display a set of images
e work with multiple images

e use automatic target detection

e select various measures

e gather data from an image

If you are unfamiliar with any of these operations, please consult the appropriate tutorial
lesson in MCID Analysis Tutorials, and the appropriate sections in the online MCID
Analysis Reference Manual.

The tutorial uses a set of image files contained in the Stereology Tutorial Data. The
Tutorial Data set is included on the MCID Analysis installation CD-ROM. If you have
not installed the Tutorial Data, please do so now. Select the Custom installation option
and install the Stereology Tutorial Data component. See the “Software Installation”
section in the MCID Analysis Start-Up Guide, for complete instructions.

In the Stereology study type, many stereological parameters (e.g., sampling frames, test
probes, intersection points, etc.) are superimposed over images in a variety of different
overlay colors. The actual colors in which these features are displayed is determined by
the current cursor color. In this tutorial lesson, we refer to particular features by the color
they appear when the cursor color is set to red. Before beginning the tutorial, set the
cursor color to red. Adhering to this overlay color scheme will help you easily identify
particular stereological parameters when they are described in the tutorial.

TO SET THE CURSOR COLOR:

1. Move the cursor to the Image View.

2. Press <F3> until the cursor turns red.

Selecting the Stereology Study Type

TO SELECT THE STEREOLOGY STUDY TYPE:

1. Open the Settings menu and click on Study.
2. Select the Stereology option.

Procedure: 2D Frames and 3D Probes

This section describes the procedures used to derive 2D Frames and 3D Probes
measures. The procedure for deriving 3D Disector measures is slightly different, and
requires a different set of sections. For these reasons, the 3D Disector method is
described in a separate section.
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TO LOAD IMAGES:

1. Open the Settings menu and select the Display format option.

2. The Display Format dialog box appears on the screen (Figure 15). Select 4 as the
total number of channels and 1 as the total number of views.

Figure 15: The Display Format dialog box.
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3. Open the Image menu and select Image set — Retrieve.

4. When the Retrieve Image Set dialog box appears (Figure 16), Press the [Add]
button to specify which image files to load.

Figure 16: The Retrieve Image Set dialog box is used to load a set of image files in a

single operation.
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5.

The Select Files dialog box will now appear (Figure 17). Navigate to the
directory where the sample images are stored (the default directory is \MCID
Analysis 7.0\IMG) and retrieve the images SV1.IM — SV4.IM. To select a file,
first click on it then click on the [Add] button. The selected file appears in the list
of Images to load section of Figure 16. There are two ways to select more than
one file at a time:

1) hold down the <Ctrl> key while clicking on the filenames.

i1) hold down the <Shift> key while clicking on the first file in a
consecutive list and then clicking on the last file.

Figure 17: The Select Files dialog box is used to select the files that comprise the image

set.
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Press [Done] to return to the Retrieve Image Set dialog box.

Specify retrieval options (overlay, calibrations, rotation) and [Sort] the images if
necessary.

Turn on the Channels radio button and enter a Starting channel number as
channel 1.

Click [OK] to load the images into consecutive channels. Images load in the
order that they appear in the list.

10. The images are now displayed in Channels 1 — 4.

Selecting Measures

Stereological measures are grouped into three categories: 2D Frames, 3D Probes, and 3D
Disectors. These measurements can be selected singly or in combination, allowing
multiple stereological measurements to be carried out simultaneously. Because of the
different ways in which specimens must be sectioned, however, 3D Disectors measures
cannot be combined with 2D Frames or 3D Probes measures.
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When you select Stereology as your study type, the data table initially contains 3D
Disectors measures (N, Vs, Nv).

TO SELECT ADDITIONAL MEASURES:

1. Open the Sample menu and select Measures selection.

2. The Measures Selection dialog box appears on the screen (Figure 18).

Figure 18: The Measures Selection dialog box is used to select different stereological
measures.
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3. From the Available Measures list, open the Stereo: 2D frames and Stereo: 3D
probes categories by clicking on the “+” button. Add every measure in these two
categories to the list of Selected Measures.

4. Click [OK] to proceed. The selected measures appear as separate columns in the
data table.

Stereo Grid Definition

To calculate 3D Probes measures (Sv, mean surface volume; Vv, mean volume), linear
probes are oriented around regularly spaced points in a “sampling grid.” Before the
specimen is sampled, the sampling grid should be adjusted to the appropriate size. The
section type must also be specified, to ensure that the appropriate algorithms and test
probes are used.

ADJUSTING THE SAMPLING GRID:

1. Click on the Stereo grid icon (in the Application toolbar) to access the sampling

grid options.

2. A sampling grid appears over the image in the current channel. The Sampling
Design dialog box also appears (Figure 19), as well as a set of Stereo Grid tools:
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” Stereoarid Tools = [+ 355 @ (2 |

The Sampling Design dialog box is used to specify a section type and sampling
grid size. The Stereo Grid tools allow you to adjust the grid with the mouse.

Figure 19: The Sampling Design dialog box is used to specify a section type and sampling
grid size.
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3. Under the Section Type heading select Vertical. This establishes an appropriate
set of algorithms and test probes that will be used to derive the 3D Probes
measures.

4. To adjust the size of the sampling grid, select the Size tool from the toolbox:

5. Position the cursor over the image in Channel 1. Move the cross-hair cursor over
any grid point and it becomes a pointing finger. Press the left mouse button and
the grid point becomes one corner of a variable dimension box, defined by its
three neighboring points. Drag the grid point to a new location and release the
mouse button. The grid is redrawn using these coordinates as a reference. Note
that the grid dimensions are updated in the Sampling Design dialog box.

6. The grid size should be chosen with reference to the size of the features of
interest. The basic goal is to adjust the grid size so that none of the features of
interest contain more than one grid point (as in Figure 20, below). Scroll through
all of the images in the set to find the largest feature of interest. Use this feature
as a reference when sizing the grid (i.e., adjust the grid size so that the feature
contains only one grid point).
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Figure 20: The size of the sampling grid should be adjusted so that no feature of interest
contains more than one grid point.

7.

10.

1.

03-MW-0080

The simplest way to establish the appropriate grid size is to use the Outline or
Autoscan B tool to define a feature of interest. MCID Analysis then uses the
feature’s dimensions to set the grid size. For example, select the Outline tool
from the Stereo Grid tool box:

Trace around one of the smaller target profiles with the left mouse button. When
you release the mouse button, MCID Analysis adjusts the grid interval so that it
matches the dimensions of the target profile. However, note that larger target
profiles contain more than one grid point. Thus, the grid is too small for this
sample. For proper grid adjustment, trace around the largest feature of interest.

The Autoscan B tool may be used in lieu of the Outline tool:

Place the hollow arrow cursor on a background region next to a target profile and
click the left mouse button. When the cursor becomes a solid arrow, place it over
a profile and click again. The target outline is shown in red and its dimensions
establish the grid size for this sample. To establish an optimal grid size, use the
tool to define the largest feature of interest in the sample. This should yield
approximately 18 rows of points with an interval of about 36 pm.

Return to the Stereo Grid toolbox and select the Shift icon.
[+,

Position the cursor over the image in Channel 1. Move the cross-hair cursor over
any grid point. When the cross-hair turns into a pointing finger, drag the grid
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point to a new XY coordinate and release the mouse button. When you release
the mouse button, the grid will align itself to a new position.

12. The position of the sampling grid should be random with reference to the image.
The Shift icon lets you randomize grid positions.

13. Return to the Sampling Design dialog box and click [OK] to proceed.

TO ESTABLISH DETECTION CRITERIA:

1. Click on the Scan Area icon to turn on the automatic target detection and
measurement mode:

2. The Scan Area dialog box appears (Figure 21). The Scan Area dialog box is used
to define target detection criteria. In the middle of the dialog box there is a set of
slider controls for setting the upper and lower target density limits. Together,
these limits are called a “Segmentation Range”. The Highlighting box is simply
a visual aid to help establish the Segmentation Range.

Figure 21: The Scan Area dialog box is used to define criteria used for automatic target
detection and measurement.
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3. Set the Highlighting option to Target and set the highlight color to Red.

4. To set the density criteria, place the cursor in either of the two flags on the right
side of the controls and drag them up or down. The upper flag controls the
brightness limit and the lower flag controls the dark limit. The gray level value of
each threshold is displayed in the flag as you drag it. Objects that fall within the
range of the upper and lower density limits are filled in red (highlighted). The
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goal is to adjust the density criteria so that the features of interest are filled with
red.

Move the upper flag to show about 246 Levels and the lower one to about 20
Levels. With these criteria, all of the target profiles in the sample images are
highlighted in red.

Click on [OK] to exit. The target highlighting disappears when you close the
dialog box.

Gathering Data

Images are sampled with a tool called a “sampling frame” or “counting frame”, a
rectangular box with broken lines for its upper and right boundaries (inclusion lines) and
solid lines for its left and lower boundaries (exclusion lines). Data are derived from target
profiles that fall completely within its boundaries plus any target, which touches the
inclusion lines. Targets that touch the exclusion lines are not included in the sample.

TO START GATHERING DATA:

1.

03-MW-0080

Select the Continuous frame tool from the Stereo Sample Tools

toolbar/toolbox:

Move the cursor to the image in Channel 1. The goal is to size the sampling
frame to select as many target profiles as possible, while making sure that the
broken sides of the frame (inclusion lines) avoid targets that intersect the edges of
the image (see Figure 22). To adjust the size of the frame, move the mouse while
holding down the <Ctrl> key.

Press the left mouse button to sample the image. MCID Analysis scans the
sampling frame (and the region adjacent to the inclusion lines) for targets that fall
within the segmentation range and gathers data from them. To be included in the
sample, a target profile must:

i) Satisfy the detection criteria (i.e., fall within the established density
segmentation range)

i1) Fall within the boundaries of the sampling frame, or
ii1) Touch an inclusion line

On the image, sampled target profiles are outlined in red.
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Figure 22: The sampling frame should be adjusted to include as many profiles as
possible. However, make sure that the inclusion lines (broken lines) do not touch targets
that also touch the edge of the image.

4. Repeat the sampling procedure for the remaining images in the series. Later,
we’ll use the auto-sampling feature to sample an entire image set in one
operation.

Reporting Data

Data are reported in the data table as each image is sampled. Each line in the table
represents data from a single sample. Note that MCID Analysis automatically uses the
image filenames as Section labels. Each column in the data table represents a measure that
was selected at the start of the tutorial. Data are defined as follows, in units that reflect
the image calibrations.

Ns Number of target profiles sampled

As  Area sampled (pm?)

Na Number of target profiles per um?’ (abbreviated as pm-?)
Vv Ratio of target volume to sample volume

Aa Ratio of target intercepts to total intercepts

Sv  Mean surface area per um’ (abbreviated as pm-')

Vm Mean target volume (um’)

Note: Since the images are calibrated in microns, Na is very small. The value of Na
would be much larger (10° times greater) if it was expressed per mm” (i.e., if
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the images were calibrated in millimeters instead of microns). However, Vm
would then be very small.

Data are also displayed in graphical form. The graph area displays the incremental
calculation of any single measure in the data table, plotted against the parameter that is
used to calculate it. Sv, for example, is plotted as a function of the number of test probes
used in its calculation. It is a useful way to monitor the reliability of particular measures
as sampling progresses. To select the measure to plot in the graph area, click on its
column heading in the data table.

Editing the Data

Automated target detection rarely works as perfectly as it does with these specially
constructed sample images. Inclusion and exclusion errors are bound to occur with real
tissue specimens, no matter how carefully you define the target detection criteria. Some
post-sampling editing of data is usually necessary to overcome deficiencies in the
automated target detection process.

MCID Analysis provides two ways to edit stereological measures. One way is to add or
delete targets in the sampled image(s). The other way is to edit the stereological probes
upon which particular measures (i.e., Sv, Vm) are based.

TO ADD OR DELETE TARGETS IN A SAMPLED IMAGE:
1. Open the Edit menu and select the Stereo editing tool option (or press <F8>).

2. Select Scan windows editing as the editing mode (Figure 23).

3. The Stereo Sample toolbox becomes the Scan Editing toolbox, which contains
tools for adding or deleting targets. Select the Delete tool:

Figure 23: MCID Analysis provides two editing modes for stereological data. Select
“Scan windows editing” to add or delete targets in sampled images. Select “Stereology
editing” to edit the probes upon which a measure is based.

Stereology Editing Modes il

Select mode

¥ Scan windows editing

" Stereology editing [#a]

|

4. Move the cursor over the image. The arrow becomes an inverted “V”. Click the
cursor on any sampled (i.e., red) target profile and the target fill color disappears.
Data that correspond to the sample are updated in the data table. Delete a few
more profiles.
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5.

6.

Remaining tools are used to add targets to the sample. These tools operate just
like sample tools. Select one of the Autoscan tools and use it to add one of the
targets you deleted in Step 4. To add it, click on background, then click on the
target profile. Note again that the data table is automatically updated each time a
target is added to the sample.

Click [Done] to exit Scan windows editing.

To EDIT SPECIFIC STEREOLOGICAL PROBES:

1.

7.

First select the measure you wish to edit by clicking on its column heading in the
data table. Click on the Sv column heading. On the images, MCID Analysis
displays the probes and intersection points that were used to derive the Sv
measure.

Open the Edit menu and select the Stereo editing tool option (or press <F8>).
Select Stereology editing as the editing mode (Figure 23).
Select the Surface probe tool from the Stereo Editing tool box:

The Surface probe tool is used to edit the mean surface density measure (Sv), by
adding or deleting intersections between test probes and target profile boundaries.
On the sampled images, intersections are shown as small green circles (Figure
24).

To delete an intersection point, click on it with the right mouse button. Click the
left mouse button to add a new intersection point. Data are updated accordingly
as each probe is edited.

Click [Done] to exit editing mode, or press <F8>.

Figure 24: A sampled image showing the probes and intersection points used to estimate
the mean surface density measure (Sv).
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Compiling Data
The Table toolbar provides two summary tables for displaying stereological data:

” ITarget kable j

Data is currently displayed in the Target table, which contains data from each individual
sample. In order to generate measures that are representative of the entire specimen, we
must pool data obtained from individual samples (i.e., across all sections).

TO COMPILE DATA ACROSS ALL SECTIONS:
1. Display the Table toolbar if it isn’t visible (View > Table bar).

2. Select the Stereology table from the drop-down list.

MCID Analysis computes and displays the appropriate summary value (mean, total) for
all measures. The table also summarizes the appropriate stereological parameters upon
which the measure is based (e.g., # frames, # intercepts).

The data can be printed, saved to disk, or exported to other programs in text or
spreadsheet format.

Before proceeding to the next tutorial section, please return to the “Target table”
and press the [Clear]| button.

Procedure: 3D Disectors

This section describes the procedures used to derive 3D Disector measures. Unlike 2D
Frames and 3D Probes measures, 3D Disector measures are derived from serially
adjacent sections, separated by a known distance and perfectly registered (aligned) with
each other.

TO LOAD IMAGES:

1. Press <Shift+F5> to clear all of the displayed images. Press <Shift+F4> to clear
all overlays.

2. Open the Image menu and select Image set > Retrieve.

3. When the Retrieve Image Set dialog box appears (see Figure 16), navigate to the
directory where the sample images are stored (the default directory is \MCID
Analysis 7.0\IMG) and retrieve the images DS01.IM — DS16.IM. Retrieve the
images into a Storage list with their calibrations.

4. Click [OK] to proceed.

5. A small Retrieve Image File dialog box appears on the screen (Figure 25). Press
the [Current] button to display the first image file (DS01.IM) in the current
channel. Use the [Previous] and [Next] buttons to navigate through the image set
as required.
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Figure 25: The image storage list is used to load an image set into the current channel,
one file at a time.

Retrieve Image File x|
Current: Ch1 DS07.1k4
|~ DA, ASTEREOMMGADSOT. 1M

Prewvious | Current | M et I

TO SELECT MEASURES:

1. Open the Sample menu and select Measures selection. The Measures Selection
dialog box appears on the screen (see Figure 18).

2. Press the [Clear] button to remove the previous 2D Frames and 3D Probes
measures from the list of Selected Measures.

3. Open the Stereo: 3D Disector group of measures and add every measure to the
list of Selected Measures.

4. Click [OK] to proceed. The selected measures (N, Nv, and Vs) appear as

separate columns in the data table.

TO ESTABLISH DETECTION CRITERIA:

1.

2,

The segmentation range that was established for the SV1.IM — SV4.IM image set
is sufficient for the current image set. However, if you wish to establish other
detection criteria, <Ctrl> - click on the Scan Area icon to re-display the Scan

Area dialog box:
<Ctrl> + IEl

Click on [OK] to exit.

Gathering Data

These images are also sampled with a “sampling frame”. Data are derived from target
profiles that fall completely within its boundaries plus any target, which touches the
inclusion lines. Targets that touch the exclusion lines are not included in the sample.

In this example, however, we will use another kind of sampling frame. Given the size of
the image set (16 image files), we will also use MCID Analysis’s auto-sampling feature
to sample the entire set in one operation. Either of these features ensures that the same 2D
coordinates are sampled in every image.

TO GATHER DATA:

1.
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Open the Stereo Sample tool box and double-click on the Channel frame tool:
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3. When the Stereology Frame Cursor Settings dialog box appears (Figure 26), turn
on the Auto sampling on sections option.

4. Click [OK] to proceed.

Figure 26: The Frame Cursor Settings dialog box is used enable automatic sampling
across an entire image set.

Stereology Frame Cursor Settings ﬂ
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5. Select the Channel frame tool and move the cursor to the first image. Again, the
goal is to size the sampling frame to select as many target profiles as possible,
while making sure that the broken sides of the frame (inclusion lines) avoid
targets that intersect the edges of the image (see Figure 22).

6. Unlike the Continuous frame tool, the Channel frame is locked into a fixed
position within a channel. To adjust the initial size of the frame, move the mouse
while holding down the <Ctrl> key. To position the frame, move the mouse
while holding down the <Shift> key.

7. Click the sampling frame in the first image in the series. When the Auto
Sampling On Sections dialog box appears (Figure 27), select the Image list
option.

Figure 27: The Auto Sampling On Sections dialog box.

Auto Sampling On Sections il
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Images
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Sample I Cancel | Help |

8. Click the [Sample] button to begin sampling the image set. MCID Analysis
generates the appropriate test probes (i.e., disectors), scans each image for targets
that meet the detection criteria, and reports the results in the data table.
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9.

10.

1.

12.

On the images, target profiles that fall within the segmentation range are filled
with red overlay. To be counted as a 3D target, a target profile must be absent
from the preceding section (the “lookup” section). Profiles that are absent from
the lookup section (i.e., new 3D target tops) are outlined in green.

Data are reported in the data table as each image is sampled. Each line in the
table represents data from a single sample and is designated by the image
filename. Since the first image in the series has no corresponding “lookup”
section, no data are displayed for this image.

Each column in the data table represents a measure that was selected at the start
of the tutorial. Data are defined as follows, in units that reflect the image
calibrations.

N  Number of 3D targets contained in the sample
Nv  Number of 3D targets per um’ (abbreviated as pm™)

Vs  Volume sampled (pm?)

Data are also displayed in graphical form. To select the measure to plot in the
graph area, click on its column heading in the data table.

Editing the Data

To overcome deficiencies in the automated target detection process, MCID Analysis
provides two ways to edit 3D Disector measures. One way is to add or delete 2D targets
profiles in the sampled image(s). The other way is to add or delete 3D target tops.

To ADD OR DELETE 2D TARGET PROFILES IN A SAMPLED IMAGE:

1.
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Select the image you wish to edit by highlighting the corresponding line of data in
the data table.

Open the Edit menu and select the Stereo editing tool option (or press <F8>).
Select Scan windows editing as the editing mode (see Figure 23).

Select the Delete tool from the Scan Editing toolbox:

Move the cursor over the image. The arrow becomes an inverted “V”. Click the
cursor on any 2D target profile and the target fill color disappears. Data that
correspond to the sample are updated in the data table where applicable. Delete a
few more profiles.

The remaining tools are used to add targets to the sample. These tools operate
just like sample tools. Select one of the Autoscan tools and use it to add one of
the targets you deleted in Step 5. To add it, click on background, then click on
the target profile. Note again that the data table is automatically updated where
applicable.
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7. Click [Done] to exit Scan windows editing.

To ADD OR DELETE 3D TARGETS:

1. First select the measure you wish to edit by clicking on its column heading in the
data table. Click on the N or Nv column heading. Select the image you wish to
edit by highlighting the corresponding line of data in the data table.

2. Open the Edit menu and select the Stereo editing tool option (or press <F8>).
3. Select Stereology editing as the editing mode (see Figure 23).
4. Select the Profile pointer tool from the Stereo Editing tool box:

On sampled images (other than the first image), 2D target profiles are displayed
in red. Profiles that were not present in the preceding section (i.e., the tops of new
3D targets) are outlined in green. To delete a 3D target from the sample, click on
it with the right mouse button. It then becomes a 2D target profile. To add a 2D
target profile to the sample, click on it with the left mouse button. Data (N and
Nv) are updated accordingly.

5. Press [Done] to exit editing mode, or press <F8>.

Compiling Data
Data is currently displayed in the Target table, which contains data from each individual

sample. In order to generate measures that are representative of the entire specimen, we
must pool data obtained from individual samples (i.e., across all sections).

TO COMPILE DATA ACROSS ALL SECTIONS:
1. Display the Table toolbar (View > Table bar) if it isn’t visible.

2. Select the Stereology table from the drop-down list.

MCID Analysis computes and displays the appropriate summary value (mean, total) for
all measures.

The data can be printed, saved to disk, or exported to other programs in text, Lotus”™ 1-2-
3, or Microsoft® Excel format.
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